DAP 11
Accessing Spatial Data Worldwide
MULTI-CLIENT TUTORIAL

www.geosoft.com
## Contents

### Overview 1

**Geosoft DAP 11** 1

**Key Functionality** 1
- Finding Data 1
- Previewing Data 1
- Retrieving Data 2

**Accessing DAP Servers** 2
- Accessing DAP Servers from a DAP-enabled Application 2
- Accessing DAP Servers through a Web Browser 2
- Accessing DAP Servers Using Dapple in Standalone Mode 3

**Finding More Information** 4

### Tutorial 1: Accessing DAP Servers from DAP-enabled Applications 6

**DAP Find Data** 6
- Accessing the DAP Interface with DAP Find Data 6
  - Accessing DAP From a Project without an Open Map 6
  - Accessing DAP From a Project with an Open Map 7
- Searching for Data with DAP Find Data 9
  - SEARCHING FOR DATA USING THE BROWSER MAP PANNE 10
  - SEARCHING FOR DATA USING the Area of Interest Pane 11
  - Filtering search results using Metadata keywords on the results page 12
- Previewing Data in Get DAP Data 14
  - Graphical Renditions 14
  - Metadata 17
DAP Overview

This document explains how to use Geosoft DAP 11

- From within DAP-enabled applications – Tutorial 1
- Through a web browser – Tutorial 2
- With the use of Dapple – Tutorial 3

Note: The operations you must perform to complete a specific tutorial are shown in blue.

Geosoft DAP 11

Geosoft DAP (Data Access Protocol) is a technology that enables the search, preview, and retrieval of spatial data from corporate data repositories through the Internet or an intranet.

This technology effectively overcomes data access and distribution challenges, including insufficient bandwidth for large datasets, format incompatibility, lack of standards, and map projection incompatibilities. Geosoft DAP (referred to further in this tutorial as DAP) makes the search, evaluation, and retrieval of large-volume spatial data more efficient and effective for geoscientists.

The DAP publishing service makes spatially located data accessible to virtually any network client, as well as to remote workstations through web browsers or web client applications. The data can also be accessed from a variety of DAP-enabled desktop applications, including Geosoft’s Oasis montaj and Oasis montaj Viewer. Geosoft has also developed DAP plug-ins for MapInfo and ArcGIS that enable users to access different Geosoft file formats and download geosciences data from a DAP server.

Key Functionality

The DAP server enables you to search, preview, and retrieve published spatial data (such as exploration data). It also enables on-the-fly windowing, re-projecting, and re-sampling of the various data formats.

Finding Data

You can search for the relevant spatially located datasets using queries based on spatial extent and/or associated metadata content.

Previewing Data

DAP enables data in most spatial formats to be previewed along with any associated metadata. Supported data formats display a rendered image in the client browser map window. Previewing all or a windowed portion of the data enables users to quickly find the data they need.
2 DAP Overview

Retrieving Data

Using a supported DAP client, you can retrieve entire sets of spatial data, or windowed parts thereof, at a specified resolution, in multiple formats, and in any coordinate system.

In DAP-enabled applications, the DAP data retrieval service imports the requested data directly into the current project and displays these data in a new or existing map or database.

In web applications, the DAP data retrieval service places the resulting data in a ZIP file and passes the URL of that ZIP file back to the requesting application, that will give you the option to download the file to your workstation.

Accessing DAP Servers

You can access data residing on a DAP server in three ways:

- From within a DAP-enabled application connected to a network
- Through a standard web browser
- With Dapple in standalone mode

Note: Third-party developers can use the Geosoft DAP API to build custom data access applications. For details, see the DAP Server Manual, available on the Geosoft web site.

Accessing DAP Servers from a DAP-enabled Application

A DAP-enabled application is software that has built-in DAP data browsing and download functionality. Geosoft’s Oasis montaj, and the freely available Geosoft Oasis montaj Viewer, are examples of DAP-enabled applications. Within these applications, two alternatives are available to access a DAP server: through Find Data or Find Data with Dapple.

In Oasis montaj, these built-in DAP data discovery tools enable you to search for and retrieve data within the context of a project. Wherever possible, data selected for download is automatically windowed to your project boundaries, re-sampled to a resolution appropriate to the project, and re-projected to the coordinate system of the project.

Geosoft also provides DAP plug-ins for ArcGIS (included with Target for ArcGIS) and MapInfo that can be used to find and retrieve data in the context of your GIS project.

Accessing DAP Servers through a Web Browser

DAP servers can be accessed directly through a standard web browser. There are some functional limitations for re-projecting and re-sampling when using this method, but the search and retrieval functionality remains the same.
Accessing DAP Servers Using Dapple in Standalone Mode

**Dapple** is a global data explorer designed to provide an open and optimal environment for visualizing, presenting, and sharing massive quantities of geoscientific data on desktop computers. Its functionality and design are similar to those of the Google Earth viewer.

**Dapple** as a standalone product is similar to *Find Data with Dapple* that is embedded in Geosoft applications like **Oasis montaj**. The only difference is that users of **Dapple** within Geosoft applications have licensed access to datasets which enables them to download actual data.

**Dapple** enables you to:

- Display a variety of data formats positioned on a three-dimensional earth surface viewed from a virtual observation point in the space. For a complete list of data formats, refer to *Appendix 1: DAP File and Data Types* or the Geosoft website.
- Rotate, pan, zoom, and tilt the 3D Earth image to view your data in the best way
- Save data views and share them with colleagues
- Add new Geosoft DAP and WMS servers of interest
- View GeoTIFF files

**Dapple** enables you to browse, discover, and display graphically rich data from available global and corporate spatial servers: Geosoft DAP, NASA, USGS, and WMS servers.

The **Dapple** project is an open-source activity sponsored by Geosoft and derived from the **NASA World Wind** open source project.
Finding More Information

Additional information about Geosoft DAP is available:

- In the Oasis montaj Help system
- In the Geosoft Oasis montaj Viewer Help system
- At the Geosoft website: www.geosoft.com
- From Geosoft support personnel

The following list provides contact information for Geosoft offices around the world:

**North America**

Geosoft Inc.,
85 Richmond St. W., 8th Floor
Toronto, Ont.,
Canada
M5H 2C9
Tel. (416) 369-0111
Fax (416) 369-9599
Email: info@geosoft.com

**Europe and North Africa**

Geosoft Europe Ltd.
20/21 Market Place, First Floor
Wallingford, Oxfordshire
OX10 OAD United Kingdom
Tel: +44 1491 835 231
Fax: +44 1491 835 281
Email: info@geosoft.com

**South America**

Geosoft Latinoamerica Ltda.
Praça Floriano 51 / 19º Andar
CEP: 20031-050, Centro
Rio de Janeiro, RJ, Brasil
Tel: (55-21) 2532-0140
Fax: (55-21) 2532-7197
Email: info@geosoft.com

**Australia and Southeast Asia**

Geosoft Australia Pty. Ltd
350 Hay Street
Subiaco WA 6008
Australia
Tel 61 (8) 9382 1900
Fax 61 (8) 9382-1911
Email: info@geosoft.com

**South and Central Africa**

Geosoft Africa Ltd.
Buren Building, Second Floor
Kasteelpark Office Park
c/o Nossob & Jochemus Streets
Erasmuskloof X3, Pretoria
Tel: 27 12 347 4519
Fax: 27 12 347 6936
Email: info@geosoft.com
Tutorial 1: Accessing DAP Servers from DAP-enabled Applications

The DAP server functionality is built into the basic package of Oasis montaj. DAP is also accessible from within Geosoft Oasis montaj Viewer, and from within ArcGIS and MapInfo using free Geosoft plug-ins.

This tutorial describes the DAP GUI available in Oasis montaj. It also describes the procedures used to:

- Search for relevant data
- Preview the relevant data
- Download data into your project

Find Data and Find Data with Dapple are the two methods used to connect to DAP servers from within Oasis montaj.

DAP Find Data

Use the Find Data dialog to search for relevant data on one or more DAP data servers. For further information on the various Get Data interface tools, refer to the Oasis montaj Help system.

Accessing the DAP Interface with DAP Find Data

Within Find Data, there are two ways to access the DAP interface:

- From a project without an open map, where the DAP interface displays all the worldwide data available on the DAP server
- From a project with an open map having a defined coordinate system, where the DAP interface displays data filtered to the spatial extent of that map

ACCESSING DAP FROM A PROJECT WITHOUT AN OPEN MAP

TO ACCESS THE DAP INTERFACE FROM A PROJECT WITHOUT AN OPEN MAP:

1. Create a project in Oasis montaj. For procedures, see the Oasis montaj online help system.
   
   For this tutorial, name the project “Alaska.gpf”.

2. From the DAP menu, select Find Data

If you are accessing DAP for the first time, the Dap Server Manager dialog is displayed. DAP connects to the Geosoft DAP Data server as its default server. You are prompted to confirm this connection.

The Geosoft DAP Data server contains all the data you need to complete this tutorial.

Note: For procedures used to add, enable, and connect to other DAP servers, see the Managing DAP Servers section.
• You are now connected to the Geosoft DAP Data server and the Get DAP Data window is displayed.

The Browser Map section displays the world map. The Results page displays all the servers DAP is connected to and all the datasets available.

ACCESSING DAP FROM A PROJECT WITH AN OPEN MAP

Note: This section is not applicable to Geosoft Oasis montaj Viewer. In the viewer, if you do not have a map with a set projection, and you know the longitude/latitude of the data range, you can display a new map by selecting New Map from the DAP menu. A default projection will be set to the new map.
TO ACCESS THE DAP INTERFACE FROM A PROJECT WITH AN OPEN MAP

1. In your project, create or open a map with a defined coordinate system. For procedure, see the Oasis montaj Help system.

   In the Alaska project, create an empty map with the following parameters:
   
   - Minimum X = -159.79
   - Minimum Y = 62.93
   - Maximum X = -148.56
   - Maximum Y = 70.44
   - Distance Unit = degree (POSC)
   - Projections parameters
     - Coordinate system = Geographic (lat, long)
     - Datum = WGS 84
     - Local Datum Transform = [WGS 84] World
   - Map name = Alaska1.map
   - Map Template = landscape letter
   - Map Scale = 100

   Leave the map open in the current project.

2. From the DAP menu, select Find Data.
The *Get DAP Data* window is displayed.

The *Browser Map* pane displays the part of the world map that corresponds to the boundaries of the map open in the *Oasis montaj* project (enclosed in a red rectangle). The *Results* page displays only those datasets on the default server that spatially overlap the map area.

**Searching for Data with DAP Find Data**

There are several different methods available to define the search criteria for datasets with *Find Data*:

- By defining the spatial extent of the search area in the *Browser Map* pane
- By defining the spatial extent of the search area in the *Area of Interest* pane
- By filtering the search results using metadata keywords
SEARCHING FOR DATA USING THE BROWSER MAP PAN

You can define your area of interest approximately by windowing the map displayed in the Browser Map pane. Use the navigation tools in the DAP browser window to zoom-in and -out of, centre, display in full view, and toggle the map. Refer to the Oasis montaj Help system for further details about these tools.

TO WINDOW THE AREA OF INTEREST IN THE BROWSER MAP PAN:

1. In the Area of Interest pane, click [Define Area of Interest on Map].

   The cursor changes from \[\] to \[\].

2. On the map in the Browser Map pane, click and hold down the left mouse button on any corner of the area you want to window.

3. Drag the pointer to the opposite corner of the required area, and then release the button.

   The Browser Map pane displays the area you selected. The Minimum and Maximum (X and Y) fields in the Area of Interest pane displays the coordinates of the windowed map boundaries. The list of available datasets on the Results page is filtered to include only those datasets that spatially overlap the specified area of interest.

   For example, if you set the area of interest in the Browser Map pane to Australia (change the Browser Map display from A to B), the dataset list on the Results page changes from C to D.
SEARCHING FOR DATA USING THE AREA OF INTEREST PANE

There are two ways to search for relevant datasets using the *Area of Interest* pane:

- By selecting a region of interest using the *Region* drop-down menu
- By defining a region of interest using exact coordinates

**TO SELECT A REGION OF INTEREST USING THE REGION DROP-DOWN MENU:**

1. Click on the *Region* drop-down menu.
2. Select a region of interest.

   The selected region is displayed in the *Browser Map* pane, occupying the entire map space. The region coordinates are displayed in the *Minimum* and *Maximum* (*X* and *Y*) fields in the *Area of Interest* pane. The list of available datasets on the *Results* page is filtered to include only those datasets that spatially overlap the selected region.

**TO DEFINE A REGION OF INTEREST USING EXACT COORDINATES:**

1. Enter the area coordinates in the *Minimum* and *Maximum* (*X* and *Y*) fields in the *Area of Interest* pane.
2. Click [*Set*].

   *For this tutorial, enter the following coordinates:*
   
   - Minimum *X* = -159.79
   - Minimum *Y* = 62.93
   - Maximum *X* = -148.56
   - Maximum *Y* = 70.44

   The area within the specified coordinates is displayed in the *Browser Map* pane, occupying the entire map space. The dataset list displayed on the *Results* page is filtered to those datasets that spatially overlap the specified area.
For this tutorial, the selected part of Alaska is displayed in the Browser Map pane:

The list of available datasets on the Results page is filtered to include the following datasets:

FILTERING SEARCH RESULTS USING METADATA KEYWORDS ON THE RESULTS PAGE

You can filter the datasets in the result list using a free-text search of the metadata of datasets. The search criteria that you define are cumulative (implicit AND between the individual search parameters).

For example, if you select Afghanistan as your region, and enter “magnetic” as a description keyword, the Results page will display only those datasets that spatially
correspond to Afghanistan AND contain the word “magnetic” in the description of their metadata.

**TO FILTER DATASETS USING METADATA KEYWORDS**

1. On the Results page, from the DAP Data Filter drop-down list, select the freetext search option:
   - **All** – search against all metadata content
   - **Name** – search only in the dataset name
   - **Description** – search only in the dataset description attribute
   - **Keywords** – search only in the dataset keywords attribute

   For this tutorial, select “All”.

2. In the `<enter search text>` field, type keywords to be used for dataset filtering.

   Only when searching DAP servers, the search criteria can include one or more words with special characters and simple Boolean operators. The following special characters can be placed in a word:
   - `?` – matches any single character
   - `*` – matches any number of characters
   - `~~` – numeric range; for example, “12~~25” matches all numbers between 12 and 25

   The following Boolean operators can be placed between operands (words or bracketed words):
   - **AND** – both operands must exist; for example, to search for datasets whose metadata contain both “geochemistry” and “gold”, type “geochemistry AND gold”
   - **OR** – at least one operand must exist; for example, to search for datasets whose metadata contain either “geochemistry” or “gold”, type “geochemistry OR gold”
   - **NOT** – the operand must not exist; for example, to search for datasets whose metadata contain “geochemistry” and does not contain “gold”, type “geochemistry NOT gold”

   You can use brackets to clarify the search sequence. For example: mag* AND (gold OR silver) would find all datasets whose metadata include words that begin with “mag”, and words “gold” or “silver”.

   Words or sequences with spaces must be enclosed in double quotes. For example: “North America”.

   For this tutorial, type “magnetic OR gravity.”

3. Press [Enter]

   The dataset list is filtered to include only those datasets that match both the area of interest and search text criteria.
For this tutorial, the list on the Results page should include the datasets that pertain to either magnetic or gravity measurements spatially overlapping Alaska:

- To apply/remove the text search filter, click the DAP Data Filter button on the toolbar located across the top of the Results page. As you apply and remove the area of interest and text search filters, the dataset list changes accordingly.

**Previewing Data in Get DAP Data**

Once you have sufficiently narrowed down the list of the relevant datasets (displayed on the Results page), you can select those datasets you wish to preview. For each dataset, you can view the graphical rendition of the data as well as its metadata, which is displayed in the Metadata Tool dialog.

Depending of the data file type, the rendition might include the dataset content (e.g. grids or images) or only the dataset boundaries and dataset names (e.g. documents).

**Note:** See supported data types in *Appendix 1: DAP File and Data Types.*

**GRAPHICAL RENDITIONS**

You can view the graphical rendition of datasets in the Browser Map pane. The datasets can be rendered with or without the map published by the active DAP server, viewed one-by-one, or superimposed. Users have the option to change the rendition order.

**TO VIEW GRAPHICAL RENDITIONS OF DATASETS:**

1. On the Results page, extend the hierarchy nodes to display individual datasets. For this tutorial, extend the Alaska node.
2. Select a dataset or multiple datasets for graphical rendition by selecting the check box adjacent to the dataset name.

   For this tutorial, select the NPRA TMI and NPRA ISO Gravity datasets under the Alaska node.

3. In the **Browser Map** pane, select the *View Selected Datasets* check box.

   The selected datasets are displayed on top of the published map.
The resulting Alaska display should be similar to this:

- To exclude the published map from display, in the *Browser Map* pane, clear the *Browser Map* check box.
- To zoom the map to the extents of a dataset:
  a. On the *Results* page, right-click the dataset.
  b. Select *Zoom to Dataset Extents* from the pop-up menu.
- To change the rendition order of the displayed datasets:
  a. Select the Selected Datasets tab.

  The *Selected Datasets* page opens.
In this tutorial, it should display the two selected datasets:

<table>
<thead>
<tr>
<th>Results</th>
<th>Selected Datasets</th>
<th>Get Data</th>
</tr>
</thead>
</table>

The **Selected Datasets** page lists the datasets in their current rendition order. The one on top of the list is rendered on top of map in the *Browser Map* pane. The icon to the left of the dataset name identifies this dataset’s file type. For a list of supported data types, see *Appendix 1: DAP File and Data Types*.

- To move a dataset down on the list, click in this dataset’s row.
- To move a dataset up on the list, click in this dataset’s row.
- To exclude a dataset from the graphical display, clear the check box in this dataset’s row.
- To remove a dataset from the “selected” list, click in this dataset’s row.
- To remove all datasets from the “selected” list, click on the page toolbar.

The rendition order and selection changes are reflected in the *Browser Map* pane.

**METADATA**

You can view metadata associated with the selected datasets in the Metadata Tool dialog.

**TO VIEW DATASET METADATA**

1. On the **Selected Datasets** or **Results** page, right-click a dataset.

   For this tutorial, right-click the NPRA TMI dataset.

2. From the pop-up menu, select *View Meta*.

   The metadata of the selected dataset are displayed in the *Metadata Tool* dialog.
The NPRA TMI dataset’s metadata should look as follows:

```
<table>
<thead>
<tr>
<th>Attribute</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Picture</td>
<td>NPRA_TMI.grd</td>
</tr>
<tr>
<td>Name</td>
<td>NPRA TMI</td>
</tr>
<tr>
<td>Description</td>
<td>NPRA Total Magnetic Field</td>
</tr>
<tr>
<td>Version</td>
<td>1.0</td>
</tr>
<tr>
<td>Keywords</td>
<td>Grid, TMI, Magnetic, Alaska, NPRA</td>
</tr>
<tr>
<td>CoordinateSystem</td>
<td>NAD27 / *Albers Alaska (55N, 65N)</td>
</tr>
<tr>
<td>Boundary</td>
<td>outline[NPRA_TMI.hgd]</td>
</tr>
<tr>
<td>CentreX</td>
<td>-126186.716</td>
</tr>
<tr>
<td>CentreY</td>
<td>1668546.38</td>
</tr>
<tr>
<td>BoundingMinX</td>
<td>-303186.716</td>
</tr>
<tr>
<td>BoundingMinY</td>
<td>1515348.38</td>
</tr>
<tr>
<td>BoundingMaxX</td>
<td>50813.264</td>
</tr>
<tr>
<td>BoundingMaxY</td>
<td>1822348.38</td>
</tr>
<tr>
<td>SpatialResolution</td>
<td>500</td>
</tr>
</tbody>
</table>
```

**Downloading Data in Get DAP Data**

DAP downloads the selected datasets to your workstation. It imports all datasets (except those of type document) into your open **Oasis montaj** project. If the imported dataset is of type grid, vector, or image, and if the **Display** option is selected, DAP displays it either on an existing (open) or new map. If the imported dataset is of type point data or line data, DAP displays it in the **Database** window. For GIS data sets, the vector data is displayed in the project map and attributes are displayed in the project database window. For information about supported data file types, see *Appendix 1: DAP File and Data Types*.

How the actual import is performed depends on whether you have an open map in your current project.

Without an open map:

- If the dataset to be downloaded is completely within OR completely outside your area of interest, the entire dataset is downloaded and displayed (if the **Display** option is selected) in a new map. The dataset extent is used to create the new map.
• If the dataset overlaps your area of interest, the dataset is windowed to the extent of your area of interest and displayed (if the Display option is selected) in a new map. The extent of the area of interest is used to create the new map.

• The downloaded dataset is saved in its native coordinate system. The only exception is for grid files, including Geosoft GRD, HGD, and other grid file types supported by DAP. When a grid is downloaded, it is re-projected to the coordinate system of the browser map (if the default Reproject and Resample option is selected).

With an open map:
• If the dataset is completely within your area of interest, the entire dataset is downloaded and displayed (if the Display option is selected) in the open map. Otherwise, the dataset is windowed using the extent of your area of interest.

• If the area of interest has been moved, and does not overlap the open map, we revert to the no open map case – the downloaded data is displayed in a new map.

• If the area of interest has ever been moved outside the open map extent, we also revert to the no open map case, even if the area of interest overlaps the open map when downloading data.

**TO DOWNLOAD A DATASET IN GET DAP DATA:**

1. Select the *Get Data* tab.

   The *Get Data* page opens. The list on the page includes only the datasets selected on the Selected Datasets page.

   **In this tutorial, the list should look as follows:**

   ![Results](https://via.placeholder.com/150)

   ![Selected Datasets](https://via.placeholder.com/150)

   ![Get Data](https://via.placeholder.com/150)

<table>
<thead>
<tr>
<th>Name</th>
<th>Hierarchy</th>
<th>Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>NPRA TMI</td>
<td>Alaska/</td>
<td>Geosoft DAP Data Server</td>
</tr>
<tr>
<td>NPRA ISO Gravity</td>
<td>Alaska/</td>
<td>Geosoft DAP Data Server</td>
</tr>
</tbody>
</table>

2. Select the dataset you want to download.

   **For this tutorial, select the NPRA TMI and NPRA ISO Gravity datasets.**

   The download options for the selected datasets are displayed in the lower portion of the page. Options that are available for viewing and editing depend on the file type of the selected dataset.
For the NPRA TMI dataset, the download options look as follows:

<table>
<thead>
<tr>
<th>Data</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>NPRA TMI</td>
</tr>
<tr>
<td>Filename</td>
<td>NPRA TMI grd</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Format</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution</td>
<td>3591 m</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Options</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Download</td>
<td>Reproject And Resample</td>
</tr>
<tr>
<td>Display</td>
<td>Shaded Colour Image</td>
</tr>
</tbody>
</table>

- To change the default file name, path, and/or type:
  a. Click the **Filename** row.
     The ![button] button appears next to the default file name.
  b. Click ![button].
  c. In the **Save File As** dialog, define the required file path, name, and/or type.
  d. Click **[OK]**.
- To change the default resolution of the dataset:
  a. Click the **Resolution** row.
     The ![button] button appears next to the default resolution value.
  b. Click ![button].
     The **Set Resolution** dialog is displayed.

![Set Resolution](image)

The slider enables changing the cell size down to that of the dataset (500 in the above screenshot). The **Resolution** field displays the editable default cell size.

c. Move the slider to change the grid cell size, or type the required value in the **Resolution** field.

d. Click **[OK]**.
The Set Resolution dialog closes. The new resolution value appears in the Resolution row on the Get Data page.

**Note:** The dataset resolution is represented by the grid cell size. The default resolution would sample the original data so that you receive a grid of roughly 250 x 250 cells. The higher the resolution (the smaller the grid cell size), the longer the data download takes. The data cannot be downloaded at a resolution higher than the original resolution of the dataset.

- To change the default projection/sampling option:
  a. Click the Download row.
  b. From the drop-down list that opens, select an option:
     - *Re-project* – changes the grid projection to that of the map open in the Oasis montaj project. This is not necessary, but having all your data in the projection of the working map improves the display performance and speeds up the grid processing work.
     - *Re-project and Resample* (default) – changes the grid projection to that of the current map view and re-samples the grid to the resolution you specified in Step 4.
     - *Save in Native Projection* – saves the grid in the native projection of the dataset, and in the native grid point separation closest to the requested resolution.

**Note:** Re-projection and re-sampling are carried out on your workstation, not on the DAP server.

- To change the default display option:
  a. Click the Display row.
  b. From the drop-down list that opens, select an option:
     - *Colour image* – displays the grid as a simple colour image on the map
     - *Shaded colour image* (default) – displays the grid as a shaded colour image on the map
     - *Download only, do not display* – downloads and saves the grid, but does not display it

3. Ensure that the datasets you want to download are selected on the Get Data page.
   **For this tutorial, ensure that check boxes of both the NPRA TMI and NPRA ISO Gravity datasets are selected.**

4. Click the [Get Data] button at the top of the page.

The selected datasets are downloaded to your workstation and are imported into your project.
In this tutorial, the download operation creates two grids in your project (corresponding to the two datasets you selected).

The resulting map for the NPRA TMI and NPRA ISO Gravity datasets should look similar to this:

**Managing DAP Servers in Get DAP Data**

DAP can connect to multiple data publishing servers simultaneously. You can add servers to connect to, delete servers that are no longer relevant, as well as enable and disable servers. When DAP is launched, a list of the servers it is connected to will be displayed on the *Results* page. The default server’s contents appear expanded. The default server is Geosoft DAP Data. You can set any other server as the default.

**ADDING DAP SERVERS**

**TO ADD A DAP SERVER**

1. Click the [Servers] button.

   The *DAP Server Manager* dialog is displayed.
2. Click [Add].

The Add Server dialog is displayed.

3. In the DAP Server URL field, type the URL of the server you want to add.

   For example, type http://gdrdap.agg.nrcan.gc.ca for the DAP server of Natural Resources Canada.

4. Click [OK].

   The Add Server dialog closes. The added server appears on the list in the DAP Server Manager dialog.

   The newly added server is ready for connection.

**DISABLING DAP SERVERS**

Disable the DAP servers that you do not want to connect to.

**Note:** Disabled servers are not displayed on the Results page.
24 Tutorial 1: Accessing DAP Servers from DAP-enabled Applications

**TO DISABLE A DAP SERVER:**
1. Click the [Servers] button.
   The Dap Server Manager dialog is displayed.
2. From the list, select the server to disable.
3. Click [Disable].
   DAP disables the connection to the selected server. The server will remain on the list but will appear greyed out.
4. Click [OK].

**ENABLING DAP SERVERS**
To connect to a DAP server that was previously disabled, you must enable that server.

**TO ENABLE A DAP SERVER:**
1. Click the [Servers] button.
   The Dap Server Manager dialog is displayed.
2. From the list, select the disabled server to be enabled.
3. Click [Enable].
   DAP enables the connection to the selected server. If DAP cannot establish connection to the selected server, an error message is displayed. The message suggests the steps you should take to establish the connection.
4. Click [OK].

**SETTING A DEFAULT DAP SERVER**
You can set any enabled server as the default server. When DAP is launched, the contents of the default server appear extended on the Results page.

**TO SET A DAP SERVER AS THE DEFAULT SERVER**
1. Click the [Servers] button.
   The Dap Server Manager dialog is displayed.
2. From the list, select the server you want to set as the default DAP server (the server must be denoted by the enabled icon).
3. Click [Set as Default].
   The default indicator (* in the Default field) moves from the previous default server to the selected server.
4. Click [OK].
REMOVING DAP SERVERS

You can remove DAP servers from the list of servers.

TO REMOVE A DAP SERVER:

1. Click the [Servers] button.
   
   The Dap Server Manager dialog is displayed.

2. From the list, select the server to remove.

3. Click [Remove].
   
   The selected server is removed from the list. It is no longer accessible to DAP.

4. Click [OK].

DAP Find Data with Dapple

Find Data with Dapple is similar to Find Data, and it is used to search for relevant data on one or more DAP data servers. However, Find Data with Dapple provides users with additional capabilities to perform the following tasks:

- Extract ESRI Layer files
- Download ArcGIS Map Service
- Download ESRI ArcIMS Image and Metadata Service
- View XML metadata
- View disclaimer and copyright notices

For further information on the various Find Data with Dapple interface tools, refer to the Oasis montaj Help system. For menu functions not covered in this tutorial, please refer to Appendix 2: More Dapple Features.

Accessing the DAP Interface with DAP Find Data with Dapple

Within Find Data with Dapple, there are two ways to access the DAP interface:

- From a project without an open map, where the DAP interface displays all the worldwide data available on the DAP server
- From a project with an open map having a defined coordinate system, where the DAP interface displays data filtered to the spatial extent of that map

FROM A PROJECT WITHOUT AN OPEN MAP

TO ACCESS THE DAP INTERFACE FROM A PROJECT WITHOUT AN OPEN MAP:

1. Create a project in Oasis montaj. For procedures, see the Oasis montaj online help system.
   
   For this tutorial, name the project “Alaska.gpf”.

2. From the DAP menu, select Find Data with Dapple
   
   The Geosoft DAP Data server contains all the data you need to complete this tutorial.
Note: For procedures used to add, enable, and connect to other DAP servers, see the Managing DAP Servers section.

You are now connected to the Geosoft DAP Data server and the Dapple window is displayed.

The Global Explorer and Navigation window displays the world globe. The Servers tab displays all the servers DAP is connected to and all the datasets available.
FROM A PROJECT WITH AN OPEN MAP

Note: This section is not applicable to Geosoft Oasis montaj Viewer. In the viewer, if you do not have a map with a set projection, and you know the Longitude/Latitude of the data range, you can display a new map by selecting New Map from the DAP menu. A default projection will be set to the new map.

TO ACCESS THE DAP INTERFACE FROM A PROJECT WITH AN OPEN MAP

1. In your project, create or open a map with a defined coordinate system. For procedure, see the Oasis montaj Help system.

In the Alaska project, create an empty map with the following parameters:

- Minimum X = -159.79
- Minimum Y = 62.93
- Maximum X = -148.56
- Maximum Y = 70.44
- Distance Unit = degree (POSC)
- Projections parameters
  - Coordinate system = Geographic (lat, long)
  - Datum = WGS 84
  - Local Datum Transform = [WGS 84] World
- Map name = Alaska1.map
- Map Template = landscape letter
- Map Scale = 100

Leave the map open in the current project.

2. From the DAP menu, select Find Data with Dapple.

The globe in the Global Explorer and Navigation window will rotate to display the part of the world map that corresponds to the boundaries of the map that is open in Oasis montaj.
28 Tutorial 1: Accessing DAP Servers from DAP-enabled Applications

The Global Explorer and Navigation window displays the part of the world map that corresponds to the boundaries of the map open in the current Oasis montaj project. The Data Layers pane displays only those datasets on the default server that spatially overlap the map area.

Searching for Data with Get Data with Dapple

There are several different methods available to define the search criteria for datasets in Dapple:

- By defining the spatial extent of the search area in the Global Explorer and Navigation pane
- By defining the spatial extent of the search area in the Overview map pane
- By filtering search results using metadata keywords

The Search pane displays search results under both the Servers and Web tab. For a list of servers with datasets pertaining to your area of interest, select the Servers tab. Server search results can be viewed in either Server tree view or Server list view. For a list of datasets pertaining to your area of interest found off the Internet, select the Web tab. Internet dataset search results can be view either with or without thumbnails.
SEARCHING FOR DATA USING THE GLOBAL EXPLORER AND NAVIGATION PANE

You can define your search criteria by panning the globe in the Global Explorer and Navigation pane to an area of interest. Use the navigation tools found at the bottom of the pane to zoom, tilt, rotate, and reset the globe.

TO DEFINE THE SPATIAL EXTENT OF THE SEARCH AREA IN THE GLOBAL EXPLORER AND NAVIGATION PANE:

1. In the Global Explorer and Navigation pane, click and hold down the left mouse button.
2. Drag the mouse toward the direction you want the globe to rotate.
   The globe will rotate accordingly. Repeat this step until the area of interest is displayed in front of you. Use the navigation tools found at the bottom of the Global Explorer and Navigation pane to help refine your navigation.
3. Click on the Search button.
   The servers with relevant datasets that apply to the area of interest will be displayed under the Available Servers menu.

   **Note:** If the Search button is not activated, use the zoom-in button to activate it. Also, the scroll button on the mouse provides a more refined alternative for zooming in and out of the globe.

SEARCHING FOR DATA USING THE OVERVIEW MAP PANE

There are two ways to search for relevant datasets using the Overview map pane:

- By selecting a region of interest using the Overview map drop-down menu
- By windowing an area of interest in the overview map

TO SELECT A REGION OF INTEREST USING THE OVERVIEW MAP DROP-DOWN MENU:

1. Click on the Overview map drop-down menu.
2. Select a region of interest.
3. Click on the Search button.
   The servers with relevant datasets that apply to the region of interest will be displayed under the Available Servers menu.

TO WINDOW AN AREA OF INTEREST IN THE OVERVIEW MAP:

1. On the map, click and hold-down the left mouse button on any corner of the area that you want to window.
2. Drag the pointer to the opposite corner of the selected area and release the button.
   The globe will now pan and zoom into the area of interest you have selected.
3. Click on the Search button.
   The servers with relevant datasets that apply to the area of interest will be displayed under the Available Servers menu.
FILTERING SEARCH RESULTS USING METADATA KEYWORDS IN THE TEXT SEARCH FIELD

The use of metadata keywords in a text search help produce a more relevant list of datasets based on your search.

TO FILTER DATASETS BY USING METADATA KEYWORDS:

1. In the text search box, type in keywords that can be used for dataset filtering.
   
   Only when searching DAP servers, the search criteria can include one or more words with special characters and simple Boolean operators. The following special characters can be placed in a word:
   
   • ? – matches any single character
   • * – matches any number of characters
   • ~~ – numeric range; for example, “12~~25” matches all numbers between 12 and 25
   
   The following Boolean operators can be placed between operands (words or bracketed words):
   
   • AND – both operands must exist; for example, to search for datasets whose metadata contain both “geochemistry” and “gold”, type “geochemistry AND gold”
   • OR – at least one operand must exist; for example, to search for datasets whose metadata contain either “geochemistry” or “gold”, type “geochemistry OR gold”
   • NOT – the operand must not exist; for example, to search for datasets whose metadata contain “geochemistry” and does not contain “gold”, type “geochemistry NOT gold”
   
   You can use brackets to clarify the search sequence. For example: mag* AND (gold OR silver) would find all datasets whose metadata include words that begin with “mag”, and words “gold” or “silver”.
   
   Words or sequences with spaces must be enclosed in double quotes. For example: “North America”.
   
   For this tutorial, select “United States – Alaska” as the region of interest from the Overview map drop-down menu and type “magnetic OR gravity” in the text search box.

2. Press Enter or click on the Search button.

   The servers with only those datasets that apply to both the area of interest and text search criteria will be displayed under the Available Servers menu.

3. To clear the search parameters, click the Clear Search (X) button.
For this tutorial, the list of servers with relevant datasets should include those that pertain to magnetic or gravity measurements that spatially overlap Alaska.

Previewing Data in Get Data with Dapple

Once you have narrowed the list of relevant datasets, you can select the datasets you would like to preview. For each dataset, you can view the graphical rendering in the Global Explorer and Navigation pane and metadata in the Metadata pane.

**TO VIEW GRAPHICAL RENDITIONS OF DATASETS:**

1. In the Search pane, on the Servers tab, extend the hierarchy nodes to display the individual datasets.
For this tutorial, extend the Alaska node.

2. Right-click on the dataset you want to preview and select Add to Data Layers.
   For this tutorial, select the NPRA TMI dataset to be added to the Data Layers pane.

3. The selected dataset will be added to the Data Layers pane and the graphical rendition will automatically appear, overlaying the map in the Global Explorer and Navigation pane. Click on the [Go to] button and the image will zoom in. Alternatively, you can also double-click or drag-and-drop the dataset and it will appear in the Data Layers pane.
The resulting Alaska display should be similar to this:

For more information on previewing and displaying data, refer to the Oasis montaj Help system.
METADATA

When a dataset is selected or previewed, the metadata for that dataset will appear in the Metadata pane. The dataset can be selected from either the Search or Data Layer pane. The NPRA TMI dataset’s metadata should look as follows:

NPRA TMI Metadata

- Geosoft
- Data
  - Picture: NPRA_TMI grd
  - Boundary: outline[NPRA_TMI.hgd]
  - Centre Y: 1668848.38
  - Centre X: -126186.716
  - Spatial Resolution: 500
  - Bounding Max Y: 1822348.38
  - Bounding Max X: 50813.284
  - Bounding Min Y: 1515348.38
  - Bounding Min X: -303186.716
  - Coordinate System: NAD27 / *Albers Alaska (55N, 65N)
  - Keywords: Grid, TMI, Magnetic, Alaska, NPRA
  - Version: 1.0
  - Description: NPRA Total Magnetic Field
  - Name: NPRA TMI

- Grid
  - Storage: rows from bottom left
  - Element Type: 8-byte real
  - Y Dimension: 615
  - X Dimension: 709
  - Data unit:
  - Display
    - Colour transform: 39 CMY Zones
    - Display: Interpolate
  - Statistics
    - Compression ratio: 0
    - Standard deviation: 1
    - Mean: *
    - Maximum: *
    - Minimum: *
    - Number of dummies: *

- Location
  - Axes Rotation: 0
  - Y Point Separation: 500
  - X Point Separation: 500
  - Y Origin: 1515348.38
  - X Origin: -303186.716

Downloading Data with Get Data with Dapple

DAP downloads the selected datasets to your workstation. It imports all datasets (except those of type Document) into your open Oasis montaj project. If the imported dataset is of type grid, vector, or image, and if the Display option is selected, DAP displays it on an existing (open) or new map. If the imported dataset is of type point data or line data, DAP displays it in the Database window. For GIS datasets, the vector data is displayed in the
project map and attributes are displayed in the project database window. For information about supported data file types, see *Appendix 1: DAP File and Data Types*.

How the actual import is performed depends on whether you have an open map in your current project.

Without an open map:

- If the dataset to be downloaded is completely within OR completely outside your area of interest, the entire dataset is downloaded and displayed (if the *Display* option is selected) in a new map. The dataset extent is used to create the new map.
- If the dataset overlaps your area of interest, the dataset is windowed to the extent of your area of interest and displayed (if the *Display* option is selected) in a new map. The extent of the area of interest is used to create the new map.
- The downloaded dataset is saved in its native coordinate system. The only exception is for grid files, including Geosoft GRD, HGD, and other grid file types supported by DAP. When a grid is downloaded, it is re-projected to the coordinate system of the browser map (if the default *Reproject and Resample* option is selected).

With an open map:

- If the dataset is completely within your area of interest, the entire dataset is downloaded and displayed (if the *Display* option is selected) in the open map. Otherwise, the dataset is windowed using the extent of your area of interest.
- If the area of interest has been moved, and does not overlap the open map, we revert to the no open map case – the downloaded data is displayed in a new map.
- If the area of interest has ever been moved outside the open map extent, we also revert to the no open map case, even if the area of interest overlaps the open map when downloading data.

**TO DOWNLOAD A DATASET IN GET DATA WITH DAPPLE:**

1. In the *Data Layers* pane, select the dataset(s) you want to download by clicking on it once.

   *For this tutorial, select the NPRA TMI dataset.*

   ![Data Layers](image)

   - NPRA ISO Gravity
   - NPRA TMI

2. Click on the [Extract data layers...] button.
The Extract Data Layers dialog appears.

- To change the default file name:
  a. Select the data layer.

  The selected data layer filename appears in the File name field.

  b. Enter a new file name in the File name field.

  Repeat the process with other data layers that require a file name change.

- To change the default resolution of the dataset:
  a. Enter a new resolution value in the Resolution field.

  b. Or, move the resolution slider to the desired resolution.

   **Note:** The dataset resolution is represented by the grid cell size. The default resolution would sample the original data so that you receive a grid of roughly 250 x 250 cells. The higher the resolution (the smaller the grid
cell size), the longer the data download takes. The data cannot be downloaded at a resolution higher than the original resolution of the dataset.

- Select the coordinate system you would like your data to be displayed in. The default setting is that data will be downloaded in its native projection. You have the option to have the data re-projected to your original (open) map.

  **Note:** Re-projection and re-sampling are carried out on your workstation, not on the DAP server.

- To change the default download option, select the appropriate format from the dropdown menu.

- To change the default display option:
  a. From the drop-down list that opens, select an option:
     - *Shaded colour image* (default) – displays the grid as a shaded colour image on the map
     - *Colour image* – displays the grid as a simple colour image on the map
     - *Do not display* – downloads and saves the grid, but does not display it

3. Click **[Extract]**

   A confirmation notice will appear.

   ![Extraction complete](image)

   The selected datasets are downloaded to your workstation and are imported into your project.

   *In this tutorial, the download operation creates a grid in your project (corresponding to the dataset you selected).*
The resulting map for the NPRA ISO Gravity dataset should look similar to this:

Managing DAP Servers in Get Data with Dapple

DAP can connect to multiple data publishing servers simultaneously. You can add servers to connect to, delete servers that are no longer relevant, as well as enable and disable servers. When DAP is launched, a list of the servers it is connected to will be displayed on the Results page. The default server’s contents appear expanded. The default/favourite server is Geosoft DAP Data. You can set any other server as the favourite.

SETTING A FAVOURITE DAP SERVER

You can set any enabled server as the favourite server.

TO SET A DAP SERVER AS THE FAVOURITE SERVER

1. In the Servers pane, select the server you want to set as the favourite by clicking on it once.
2. From the Servers menu, select Set as Favourite.

The selected favourite server will appear in bold.

ADDING DAP SERVERS

For further instructions on adding a DAP, WMS, or an ArcIMS server to Dapple, refer to the Dapple Help system.

DISABLING DAP SERVERS

Disable the connection to DAP servers you do not want to connect to. Disabled servers will remain on the list but will appear greyed out.

TO DISABLE A DAP SERVER:

1. Right-click the server you want to disable.
2. Select Disable from the popup menu.
The selected DAP server is now disabled.

**ENABLING DAP SERVERS**

Reconnect to previously disabled DAP servers to access available datasets.

**TO ENABLE A DAP SERVER:**

1. Right-click the disabled server that you want to connect to.
2. Select *Enable* from the popup menu.

   Dapple will now be connected to the selected server.

**REMOVING DAP SERVERS**

Removing a server will take the server off the list.

**TO REMOVE A SERVER:**

1. Right-click the server you want to remove.
2. Select *Remove* from the popup menu.

   The selected server will be removed from the list of servers.
Tutorial 2: Accessing DAP Servers through a Web Browser

The DAP functionality is available through the use of web browsers. Using the Geosoft GeoDAP Data Site as an example, this tutorial describes the DAP interface, as well as the procedures performed to complete the following tasks:

- Searching for relevant data
- Previewing relevant data
- Downloading data to your workstation

This tutorial assumes that you are working on a project in Alaska, site coordinates in WGS 84:

- Min Y = 62.93, Min X = -159.79
- Max Y = 70.44, Max X = -148.56

Your project requires external magnetic and gravity data.

DAP Interface Elements

This section briefly describes the following elements of the DAP interface displayed on the Geosoft GeoDAP Data Site:

- DAP Browser window
- Data Search and Retrieval window
  - Search tab
  - Results tab
  - Selected tab
  - Get Data tab

DAP Browser Window

The contents displayed in the DAP Browser window depend on the display options selected:

- When the Browser Map check box is selected, an interactive map published by the Geosoft DAP server, or a windowed part thereof (defined by the coordinates displayed on the Search tab) will be displayed.
- When the View Selected Datasets check box is selected, datasets selected on the Results tab will be displayed.

The navigational tools located across the top of the window enable you to pan and zoom the displayed map, as well as window the map to the extents of your area of interest.

The button in the bottom right-hand corner of the window toggles the map size.
**DAP Search Tab**

The DAP Search tab enables you to define an area of interest by performing either one or both of the following tasks:

- Selecting a geographic region from the *Region* drop-down list.
- Entering coordinates in the *Minimum* and *Maximum* (*X* and *Y*) fields.

The search can be further refined with the use of a keyword(s) search through the metadata associated with the datasets. Search results would limit the number of datasets displayed on the DAP Results tab to those that match the search criteria.

**DAP Results Tab**

The DAP Results tab displays a hierarchical tree or a flat list of datasets matching the search criteria defined on the Search tab. You can toggle between the tree view and list view using the toolbar buttons located just below the tabs.

The default hierarchical tree looks as follows:

![Hierarchical Tree Image]
The default flat list of datasets looks as follows:

### DAP Selected Tab

The DAP Selected tab lists the datasets that are selected on the Results tab.

Using controls on this page, you can:
- Change the display order of the datasets in the DAP Browser window
- Display metadata of a dataset in the Metadata viewer
- Remove datasets from the selected list
DAP Get Data Tab

The DAP Get Data tab lists the datasets selected on the Results and Selected tab.

<table>
<thead>
<tr>
<th>Name</th>
<th>Resolution</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>NPRA Gravity</td>
<td></td>
<td>CSV</td>
</tr>
<tr>
<td>Kimberlite Indicator Mineral Grain Chemistry - Slave Craton, Canada</td>
<td></td>
<td>CSV</td>
</tr>
<tr>
<td>NPRA TMI</td>
<td>1.44</td>
<td>GEOSOFT/COMPRESSED</td>
</tr>
<tr>
<td>NPRA ISO Gravity</td>
<td>1.44</td>
<td>GEOSOFT/COMPRESSED</td>
</tr>
</tbody>
</table>

**Coordinate System**

WGS 84

**Coordinates**

Minimum Y Minimum X
-60.00 -120.00

Maximum Y Maximum X
79.40 179.47

Using controls on this page, you can:

- Select the dataset(s) to be downloaded to your workstation
- Define the download options (resolution and format)
- Initiate the download

Accessing the Geosoft DAP Web Portal

**To access the Geosoft DAP web portal**

1. In your web browser, enter the following URL: http://www.geosoft.com/pinfo/dap/trydap.asp
2. From the Geosoft GeoDAP Data Site section, click on ‘Visit Live Site.’
The Geosoft DAP page opens. This page displays the DAP Browser window, which contains an interactive map published by the Geosoft DAP server.

Next to the browser map is the Data Search and Retrieval window:
Searching for Relevant Data

You can define the search criteria for relevant datasets in the following ways:

- By defining the area of interest in the DAP Browser window
- By defining the area of interest on the Search tab
- By filtering the search results using metadata keywords on the Search tab

The search criteria you define are cumulative (implicit AND between the individual search parameters). For example, if you select “Afghanistan” as your region, and enter “magnetic” as a description keyword, the Results tab will display only those datasets that spatially correspond to Afghanistan AND contain the word “magnetic” in the description part of their metadata.

Defining Area of Interest Interactively

You can define your area of interest by windowing the map displayed in the DAP Browser window.

TO DEFINE AREA OF INTEREST INTERACTIVELY, PERFORM ANY OF THE FOLLOWING OPTIONS:

- To zoom into the map displayed in the DAP Browser window:
  a. On the toolbar located across the top of the window, click 🔍. You are now in zoom-in mode.
  b. Click the map to zoom into the location of interest.
- To zoom out of the map displayed in the DAP Browser window:
  a. On the toolbar located across the top of the window, click 🔍. You are now in zoom-out mode.
  b. Click the map to zoom out of the map.
- To re-center the map displayed in the DAP Browser window:
  a. On the toolbar located across the top of the window, click 🔍. Click the location you want to be positioned in the center of the map.
- To re-display the full map published by the active DAP server in the DAP Browser window, click 🌍 on the toolbar located across the top of the window.
- To toggle the size of the map displayed in the DAP Browser window, click 📷 located in the bottom right-hand corner of the window.
- To window the area of interest in the DAP Browser window:
  a. On the toolbar located across the top of the window, click 🔍.
b. On the map, click and hold down the left mouse button on any corner of the area you want to window.

c. Drag the pointer to the opposite corner of the required area, then release the button.

The DAP Browser window displays the area you selected. The Minimum and Maximum (X and Y) fields in the Coordinates section of the Search tab will display the coordinates of the windowed map boundaries. The list of available datasets on the Results tab is filtered to include only those datasets that spatially overlap the defined area of interest.

For example, if you window the map to “Australia” (change the DAP Browser display from A to B), the dataset list on the Results tab changes from C to D.
Defining Area of Interest on the Search Page

There are two ways of defining an area of interest on the Search page: approximately or exactly.

- To define an area of interest approximately, select a region from the Region drop-down list.
- To define an area of interest precisely, enter the exact coordinates in the appropriate fields.

TO DEFINE AN AREA OF INTEREST APPROXIMATELY

1. From the Region drop-down list, select the required region.

2. Click .

The selected region displays in the DAP Browser window, occupying the entire map space. The region coordinates are displayed in the Minimum and Maximum (X and Y) fields. The list of available datasets on the Results tab is filtered to include only those datasets that spatially overlap the selected region.

TO DEFINE THE EXACT EXTENT OF YOUR AREA OF INTEREST:

1. Enter the area coordinates in the Minimum and Maximum (X and Y) fields.

2. Click .

For this tutorial, enter the following coordinates:

- Minimum Y = 62.93
- Minimum X = -159.79
- Maximum Y = 70.44
- Maximum X = -148.56

The area corresponding to the specified coordinates is displayed in the DAP Browser window, occupying the entire map space. The dataset list displayed on the Results tab is filtered to those datasets that spatially overlap the specified area.
For this tutorial, the selected part of Alaska displays in the DAP Browser window:

The list of available datasets on the Results tab is filtered to include the following datasets:

Filtering Datasets by Metadata

You can filter the list of datasets that spatially overlap your area of interest by searching metadata associated with the datasets.

To filter datasets by metadata

1. On the Search tab, use the group of option buttons beneath the Search field to select the search option:
   - *All* – search all metadata associated with the dataset
   - *Name* – search only in the dataset name
   - *Description* – search only in the dataset Description attribute
   - *Keywords* – search only in the dataset Keywords attribute

   For this tutorial, select “All”.

2. In the Search field, type keywords to be used for dataset filtering.

   The keyword criteria can include one or more words with special characters and simple Boolean operators. The following special characters can be placed in a word:

   - `?` – matches any single character
• * – matches any number of characters
• ~~~ – numeric range; for example, “12~~25” matches all numbers between 12 and 25

The following Boolean operators can be placed between operands (words or bracketed words):

• AND – both operands must exist; for example, to search for datasets whose metadata contain both “geochemistry” and “gold”, type “geochemistry AND gold”
• OR – at least one operand must exist; for example, to search for datasets whose metadata contain either “geochemistry” or “gold”, type “geochemistry OR gold”
• NOT – the operand must not exist; for example, to search for datasets whose metadata contain “geochemistry” and does not contain “gold”, type “geochemistry NOT gold”

You can use brackets to clarify the search sequence. For example: mag* AND (gold OR silver) would find all datasets whose metadata include words that begin with “mag”, and words “gold” or “silver”.

Words or sequences with spaces must be enclosed in double quotes. For example: “North America”.

For this tutorial, type “magnetic OR gravity”.

3. Click 📚.

The datasets listed on the Results tab are filtered to include only those datasets that match both the area of interest and search text criteria.
For this tutorial, the list on the Results tab should include all datasets that pertain to either magnetic or gravity measurements spatially overlapping Alaska:

<table>
<thead>
<tr>
<th>Name</th>
<th>Hierarchy</th>
</tr>
</thead>
<tbody>
<tr>
<td>NPRA Gravity</td>
<td>Alaska/</td>
</tr>
<tr>
<td>NPRA TMI</td>
<td>Alaska/</td>
</tr>
<tr>
<td>NPRA ISO Gravity</td>
<td>Alaska/</td>
</tr>
<tr>
<td>DNAG Bouguer Gravity</td>
<td>North America/</td>
</tr>
<tr>
<td>DNAG Magnetic field of North America</td>
<td>North America/</td>
</tr>
<tr>
<td>North American Magnetic Field</td>
<td>North America/</td>
</tr>
<tr>
<td>GRACE Gravity Point Data</td>
<td>World/Gravity/</td>
</tr>
<tr>
<td>GRACE Gravity Model 02</td>
<td>World/Gravity/</td>
</tr>
<tr>
<td>WDMAM Point Data (B version)</td>
<td>World/Magnetics/</td>
</tr>
<tr>
<td>WDMAM Point Data (A version)</td>
<td>World/Magnetics/</td>
</tr>
<tr>
<td>Descriptive Material of WDMAM 1.0</td>
<td>World/Magnetics/</td>
</tr>
<tr>
<td>WDMAM Grid - Model In-fill (B version)</td>
<td>World/Magnetics/</td>
</tr>
<tr>
<td>WDMAM Grid - Satellite In-fill (A version)</td>
<td>World/Magnetics/</td>
</tr>
<tr>
<td>WDMAM - Susceptibility</td>
<td>World/Magnetics/</td>
</tr>
<tr>
<td>WDMAM - RTP</td>
<td>World/Magnetics/</td>
</tr>
</tbody>
</table>

Page 1 of 2

<table>
<thead>
<tr>
<th>Name</th>
<th>Hierarchy</th>
</tr>
</thead>
<tbody>
<tr>
<td>WDMAM - TMI Analytic Signal (AS)</td>
<td>World/Magnetics/</td>
</tr>
<tr>
<td>WDMAM - RTP Lapiace Smooth</td>
<td>World/Magnetics/</td>
</tr>
<tr>
<td>WDMAM Point Data</td>
<td>World/Magnetics/</td>
</tr>
<tr>
<td>World Digital Magnetic Anomaly Map</td>
<td>World/Magnetics/</td>
</tr>
</tbody>
</table>

Page 2 of 2
Previewing Relevant Data

Once you have sufficiently narrowed down the list of the relevant datasets (displayed on the *Results* page), you can select those datasets you wish to preview. For each dataset, you can view the graphical rendition of the data as well as its metadata, which is displayed in the *Metadata Tool* dialog.

Depending of the data file type, the rendition might include the dataset content (e.g. grids or images) or only the dataset boundaries and dataset names (e.g. documents).

**Note:** See supported data types in *Appendix 1: DAP File and Data Types*.

Graphical Renditions

You can view graphical data of datasets in the *DAP Browser* window. The datasets can be rendered with or without the map published by the active DAP server, one-by-one or superimposed, with the option to change the rendition order.

**To view graphical renditions of datasets:***

1. On the Results tab:
   - Extend the hierarchy nodes to display individual datasets, or
   - On the page toolbar, click ![list view icon] to switch to the list view.

   *For this tutorial, extend the Alaska node.*

2. Select a dataset for graphical rendition:
   a. Locate the dataset on the list.

      If the list of resulting datasets is divided into several pages, use the *Previous/Next* group of arrows at the bottom of the *Results* page.

   b. Select the check box adjacent to the dataset name.
For this tutorial, select the NPRA TMI and NPRA ISP Gravity datasets under the Alaska node.

3. In the DAP Browser window, select the View Selected Datasets check box. The selected datasets are displayed on top of the published map.

   The resulting Alaska display should be similar to this:

   ![DAP Browser Window](image)

   - To exclude the published map from display, in the DAP Browser window, clear the Browser Map check box.
   - To change the rendition order of the displayed datasets:
     a. Select the Selected tab.

     The Selected page opens.
In this tutorial, it should display the two selected datasets:

<table>
<thead>
<tr>
<th>Name</th>
<th>Hierarchy</th>
</tr>
</thead>
<tbody>
<tr>
<td>NPRA ISO Gravity</td>
<td>/Alaska/</td>
</tr>
<tr>
<td>NPRA TMI</td>
<td>/Alaska/</td>
</tr>
</tbody>
</table>

The *Selected* tab lists the datasets in their current rendition order: the one on top of the list is rendered on top of the map in the *DAP Browser* window. The icon to the left of the dataset name identifies the file type of the dataset. For the list of supported data types, see *Appendix 1: DAP File and Data Types*.

- To move a dataset down on the list, click ▼ in the dataset row.
- To move a dataset up on the list, click ▲ in the dataset row.
- To exclude a dataset from the graphical display, clear the check box in the dataset row.
- To remove a dataset from the selected list, click 

**Metadata**

You can view metadata associated with the selected datasets in the *Metadata* viewer.

**TO VIEW DATASET METADATA:**

1. On the Selected or Results tab, click the icon next to the dataset name.
   
   For this tutorial, click the icon next to the NPRA TMI dataset.

   The metadata of the selected dataset is displayed in the *Metadata* viewer.

   The NPRA TMI dataset’s metadata should look as follows:

   ![Metadata: NPRA TMI](image)

   The dataset metadata are stored in the XML format, and displayed according to the XML hierarchy. By default, only the root node of the hierarchy is displayed.

2. Click the “+” sign next to the root node and then any or all required nodes to expand the metadata hierarchy.
For example:

3. To close in the Metadata viewer, click in the top right-hand corner of the viewer.

**Downloading Data**

You can download selected datasets to your workstation as ZIP files.

**To Download a Dataset**

1. Select the Get Data tab.

   The Get Data tab opens. This page lists the datasets selected on the Selected tab, along with the default download options for each dataset.
In this tutorial, the list should look as follows:

<table>
<thead>
<tr>
<th>Name</th>
<th>Resolution</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>NPRA TMI</td>
<td>0.04</td>
<td>GEOSOFT/COMPRESSED</td>
</tr>
<tr>
<td>NPRA ISO Gravity</td>
<td>0.04</td>
<td>GEOSOFT/COMPRESSED</td>
</tr>
</tbody>
</table>

**Coordinate System**

WGS 84

**Coordinates**

Minimum Y  Minimum X  
62.93      -159.79
Maximum Y  Maximum X  
70.44      -148.56

- To change the default resolution of the dataset, type the new resolution value in the *Resolution* field.

**Note:** The dataset resolution is represented by the grid cell size. The default resolution would sample the original data so that you receive a grid of roughly 250 x 250 cells. The higher the resolution (the smaller the grid cell size) the longer the data download takes. The data cannot be downloaded at a resolution higher than the original resolution of the dataset.

- To change the default format of the dataset, select the required format from the *Format* drop-down list.

2. When satisfied with the download options, click ![Get Data](image).

*General Terms and Conditions for using DAP Data* are displayed on the page. To return to the previous page, simply click on the *Get Data* tab.

3. Click ![OK](image) at the bottom of the page.

The *Opening DapDataSets.zip* dialog is displayed.

4. Select the method that you want to download the zip file.

The dataset is downloaded to the selected folder on your workstation.
Tutorial 3: Accessing DAP Servers Using Dapple in Standalone Mode

The purpose of this tutorial is to help users get started with using the features that are unique to the standalone version of Dapple.

This tutorial will focus on the features that are available in the standalone Dapple application that are not available in the DAP Client version installed with licensed applications. These functions focus on the procedures used to perform the following tasks:

- Saving Dapple views
- Viewing Dapple views
- Sending Dapple views
- Setting As My Home view
- Opening projected GeoTIFFs

To use Dapple in standalone mode, you do not need to have any Geosoft products installed on your workstation. Getting Started with Dapple found under the Dapple Help menu outlines the Dapple download procedures and system requirements.

For further information on Dapple interface elements, refer to the Dapple documentation found under the Help menu. For Dapple menu functions not covered in the tutorials, please refer to Appendix 2: More Dapple Features for further details.

Launching Dapple

Once Dapple has been installed on your workstation, you can launch it in standalone mode the same way you launch any other application under Microsoft Windows.

To launch Dapple

1. Double-click the Dapple icon on your desktop.

   If your view setting in Dapple is Ask at Startup, the following dialog is displayed.

   ![Dapple dialog](image)

   To change the view settings, refer to View Settings in Appendix 2: More Dapple Features.

2. Click [Yes] to open the last view, or click [No] to open the default view.
Saving Dapple Views

The save function enables you to capture all data layers, regardless of type, displayed in the global view into a *.dapple file. This enables you to retrieve the file later for future use.

**TO SAVE A DAPPLE VIEW, PERFORM THE FOLLOWING PROCEDURE:**

1. From the *File* menu, select *Save View As...*
   
   The *Save Current View* dialogue appears with a preview window that displays an identical snapshot of the globe view along with selected overlay settings.

2. Enter a view name or click on the browse button to select a directory or replace a previously saved file
   
   The default directory is arbitrary but usually points to *My Computer* or *Desktop*. A notes section is available for additional notes or comments.

3. Click [*OK*].

Viewing Dapple Views

The standalone Dapple application provides the capability to recall previously saved views.

**TO VIEW SAVED DAPPLE VIEWS, PERFORM THE FOLLOWING PROCEDURE:**

1. From the *File* menu, select *Open View* then *Open Saved View...*
   
   The *Open View* dialogue appears.

2. To select a view, click on the browse (\(\text{Browse}\)) button and browse to the view of interest.
   
   The selected view will appear in the preview window.

3. Click [*OK*].
   
   The selected view will open in the *Global Explorer and Navigation* window.

Sending a Dapple View

After creating a view, you have the option of sending that view through email to others. The view will be attached to an Outlook message as a file called Dapple View.dapple, along with the Dapple View.jpg counterpart.

**TO SEND A DAPPLE VIEW**

1. From the *File* menu, select *Send View To...*
   
   An Outlook message window opens. Continue using regular emailing procedures to send the message to your desired recipients.

To send multiple views, save the views you want to send and attach those views using regular emailing procedures. You will only be able to send the *.dapple files.
Setting the Default Home View

The standalone Dapple application provides the option of setting a view as your default home view.

**TO SET A VIEW AS THE HOME VIEW**

1. Create the desired view in the global viewer.
2. From the File menu, select *Set As My Home View*.

   The selected view will now appear as the default view whenever you open Dapple.

**TO REOPEN A SAVED HOME VIEW**

1. From the File menu, select Open View then Open My Home View.

   The most recently saved home view will appear in the *Global Explorer and Navigation* window.

Opening Projected GeoTIFF Images

GeoTIFF files, geographic images in *.tif extension, must be referenced in WGS 84 projection in order to be displayed in Dapple. When you open a GeoTiff, any data layers or GeoTIFFs presently open will continue to remain in both the layers list and globe view.

The extents of the GeoTIFF snapshot will be equal to the extents of the globe view and the data layers residing in it.

**TO OPEN A GEOTIFF IMAGE**

1. From the File menu, select *Open Image*...

   The Open GeoTIFF File in Current View... dialogue appears.

2. Browse to select the GeoTIFF file you want to open.

3. Click [Open].

   The GeoTIFF image will now display in the globe view. The globe will rotate to display the appropriate GeoTIFF.

   **Note:** Metadata for the selected object (GeoTIFFs) is not supported at this time.
## Appendix 1: DAP File and Data Types

The following table summarizes the file types Geosoft DAP can catalog and deliver to DAP clients.

<table>
<thead>
<tr>
<th>File Type</th>
<th>Icon</th>
<th>Cataloguing on a File System</th>
<th>Delivery to DAP Clients</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grids</td>
<td><img src="grid_icon.png" alt="Grid Icon" /></td>
<td>All common grid types (Geosoft, ESRI, ER Mapper, and more than 30 others)</td>
<td>All common grid types (Geosoft, ESRI, ER Mapper, and more than 30 others)</td>
</tr>
<tr>
<td><strong>Note:</strong> Geosoft HyperGrid format is supported for high-performance viewing and extraction of very large grid datasets</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Images</td>
<td><img src="image_icon.png" alt="Image Icon" /></td>
<td>All common image types, including GeoTIFF and ECW</td>
<td>All common image types, including GeoTIFF and ECW</td>
</tr>
<tr>
<td><strong>Note:</strong> Geosoft Hypergrid format is supported for high-performance viewing and extraction of very large image datasets</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vector</td>
<td><img src="vector_icon.png" alt="Vector Icon" /></td>
<td>Vector data layers saved as Geosoft HyperMaps</td>
<td>Geosoft MAP, ArcGIS Shape, and MapInfo TAB</td>
</tr>
<tr>
<td>Point data</td>
<td><img src="point_icon.png" alt="Point Icon" /></td>
<td>Attributed point data saved as Geosoft HyperXYZ</td>
<td>CSV, Geosoft XYZ, Geosoft GDB, ArcGIS Shape file, and MapInfo TAB file</td>
</tr>
<tr>
<td>Large-volume line data</td>
<td><img src="line_icon.png" alt="Line Icon" /></td>
<td>Large-volume line data saved in Geosoft GDB files</td>
<td>Geosoft GDB</td>
</tr>
<tr>
<td>Documents</td>
<td><img src="document_icon.png" alt="Document Icon" /></td>
<td>All other data types are supported as file documents</td>
<td>Documents are delivered “as-is” in their native format</td>
</tr>
<tr>
<td><strong>Note:</strong> Business rules can be used to provide document spatial extent upon document cataloguing</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GIS data</td>
<td><img src="gis_icon.png" alt="GIS Icon" /></td>
<td>Currently supported as GIS documents in the native GIS format (shape files, TAB files, etc.)</td>
<td>Currently delivered “as-is” in their native file format</td>
</tr>
</tbody>
</table>
Voxel | Must be cataloged in the Geosoft Voxel format (can be created/converted in Oasis montaj) | Voxels are delivered “as-is” in their native format

The following table summarizes all the supported Data Types and the DAP Server v11 and DAP Client features available for each type. Refer to the DAP Administrator Tutorial - Preparing Data section for more detailed information on how to handle the different data types.

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Search, View Metadata, Preview Data</th>
<th>Extract Data</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Download</td>
<td>Window</td>
</tr>
<tr>
<td>Grid files, which include all grid types supported by Geosoft</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Common image files</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Documents (files)</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>ECW images (requires license)</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Geosoft MAPs</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Geosoft GDB databases</td>
<td>Yes</td>
<td>Yes¹</td>
</tr>
<tr>
<td>Geosoft HyperGrids</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Geosoft HyperXYZs</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Geosoft HyperMAPs</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Voxels</td>
<td>Yes</td>
<td>Yes²</td>
</tr>
<tr>
<td>MapInfo TAB files</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>ESRI Shape files</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>ESRI Personal</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>GeoDatabases</td>
<td></td>
<td></td>
</tr>
<tr>
<td>--------------------</td>
<td>---------</td>
<td>---------</td>
</tr>
<tr>
<td>ESRI ArcSDEs</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>acQuire data</td>
<td>Yes</td>
<td>Yes(^1,2)</td>
</tr>
<tr>
<td>acQuire point</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Notes:**

1. Not supported by GeoDAP (web-client)
2. Not supported by MapInfo DAP client tool
Appendix 2: More Dapple Features

The following table summarizes the menu features of Dapple that were not covered by the tutorials.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Function</th>
<th>Function Options</th>
<th>Task Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Open Image...</td>
<td></td>
<td>Opens a previously saved *.tif file and applies it to the Dapple global view.</td>
</tr>
<tr>
<td>View</td>
<td>Grid Overlay</td>
<td></td>
<td>Displays a Longitude/latitude grid to the Dapple global view.</td>
</tr>
<tr>
<td></td>
<td>Scale Bar</td>
<td></td>
<td>Displays a scale based on the current global view in the Global Explorer and Navigation pane</td>
</tr>
<tr>
<td></td>
<td>Cross Hair</td>
<td></td>
<td>Displays a cross-hair in the centre of the Global Explorer and Navigation pane.</td>
</tr>
<tr>
<td></td>
<td>Compass</td>
<td></td>
<td>Displays a compass at the bottom left corner of the Global Explorer and Navigation pane</td>
</tr>
</tbody>
</table>
|                 | Information Overlay |                  | Displays detailed information about the following items in the top-right corner of the Global Explorer and Navigation pane:  
  - Latitude  
  - Longitude  
  - Heading  
  - Tilt  
  - Altitude  
  - Distance  
  - FOV |
<p>|                 | Tile Download Activity |            | Rectangles are displayed, on the Dapple global view, around the tiles that are currently being downloaded. |
|                 | Sunshading Dynamic  |                  | Displays sunshading to the displayed global view.                                |
|                 | Synched to Current Time |            | Displays sunshading according to the current time.                              |</p>
<table>
<thead>
<tr>
<th>Atmosphere</th>
<th>Global Clouds</th>
<th>Displays dynamic cloud coverage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Atmospheric Scattering</td>
<td>Displays dynamic atmospheric scattering around the Dapple global view.</td>
<td></td>
</tr>
<tr>
<td>Vertical Exaggeration</td>
<td>Enables you to select from a dropdown list, the level of vertical exaggeration to apply to the current global view.</td>
<td></td>
</tr>
<tr>
<td>Settings</td>
<td>Last View Settings</td>
<td>Ask at Startup</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Always Load at Startup</td>
</tr>
<tr>
<td>Advanced Settings</td>
<td></td>
<td>The advanced settings enable you to adjust Dapple’s cache settings, proxy settings and search settings.</td>
</tr>
</tbody>
</table>